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fiLE | BRI AYE A 330 L A, iZEAUE LAFIREVEREA -40°C £ 125°C , 12C #a#E D FEH£IX 16
OEIE T 23: ki

R 2-1. BEHE
PRk Brrthil ADC 7332 B RE BRI R
INA226 12C 16 fir 0.1% +10pV

21 EHAE

#£2-2 5T EVM BN EY . R MEM TotE | B S SIS EIE EMNACE (T 7= 5 E OB R,
*2-2. BEfFNE

e e
INA226EVM iR 1

FE, b EVM 7B s Sz 1 TI AR 28150 H (SCB).
2.2 FEMEE (TI) $RALRIAHE TR

A PR TN T3k | ks 5 v SBOU276. B I 2 SCHik g 5 AAT AR 7 BEXT BT 58 5 A SCRY I B B
HOCRMEIT R . BRT BT AT A wwwe.ti.com _E3RTS , tHRT AAEIN 4SS (TI) SCrkma B2 Aacy ( FLE A (800)
477-8924 ) S fh A5 B0y ( FLTE N (972) 644-5580 ) 3K1F. 1TIARS , AT SCRY bR B SCER G S R SR . 3R
2-3 5t 75 EVM MBSO . wTLUERE 3 2-3 FREEEERIRIUE 25 8 . 24 FREEH 2 www.ti.com L
FI 72 i W28 SO . SR 5 542 31 PDF SCRY .

R 2-3. R
SRR SRS SCERGR S
INA226 ##fi % SBOS547
INA226-Q1 ¥if 3% SBOS743
B h M SBOA511

3 s

% EVM 25 TR G, FT I INA226 1 EZAFEMTERE. It EVM SCRRE PCB Lk 10A fH
Wi, IS TSNS NS5 A7 4 UL R A ORAE 45 SR B 10 R FL - B i (GUI).

% EVM B EXTIX S 23R JE AR ThRE AT V-4l o BeAR R IRAEVE A B bR s BR PR LA, tHANER o e e 2 1
(EMC) MR BE T4 J7r . 1k EVM & PERE | L% i (PCB). K1 PCB #x8 EVM , E%3 T INA226. /N
) PCB nyfiy SCB #=fill#s , HT&#H: EVM 5 GUI.
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3.1 Frik

GUI SZFFELIURNS N\ B 27 17 2% UL b B 5 AR AT 45 A
M SCB 4> &1t EVM |, & F T 52 il F 451

A SCB/GUI Ezh%/\ EVM

&8 SCB J5 i thid it % WLIY micro-USB iEH:48 7o HL

4 Bk
4.1 P BERE
PLR BEEHA 4 T anfel o B A EVM.

1. WREEA SCB , iEHE—1.
a. L PAMB #5816 Z 5 PAMB #2751t
2. TEULIRENFET I LB R F 1T %% hitps://www.ti.com/lit/zip/sbac253 .
a. IRMNESEREE | JFEFREEA myTIHR
b. iHER , BARMIKIETF LA PAMB IKsh#2 5 , HtLA T SCB.
3. w41 Fow , B EVM &8 3| SCB #5148 -
a. HEEMFRMEKZA EVM K, 1ES K 4-2.
4. fFHFEMER USB B4 EVM E#:3] PC.
a. ¥ Micro USB HiZiffi N\ %] SCB il 2 b &, USB #fi iz J2 .
b. Kz 5 —Imdli A\ PC.
5. {1t Chrome. Firefox 5% Safari % #% Fidid DL~ a8 17 GUI : https://dev.ti.com/gallery/info/
CurrentSensing/INA226EVM_GUI/,
6. HIMB ARG EHEEEERE] EVM ) GND 155 (J1 51 ) .
7. R AR LER R PR RS T ol 2 S EVM B 1 51 5 56 AT J1 Sl 3 Bl 4, 1A
IN+ AT IN- 5 mdR 2= A\ RS 5

4.2 EVM #4E
FES EVM F1 SCB il 2% ( Sk s ) #ucf A |, i 4-1 PR iEs: EVM.

[E 3] R4
[Gnp | POHER.F @ &t"oooou D%’mm o TI Sensor Control Board
\9\9.9.9.9 2 Rﬂczs[n-IJ]r—
R251, 7
n RzaEm
-1 ﬁ?‘,—'_{
PR @=s=
fre==
e -
e
Wl :

ut
ovo [ hnu = el
RE|E & « /ALERT BUS N
JHHI_ -mﬁ0 ‘l_mnaw_‘sm |

INA226EUNM =
Rev' B z8

B 4-1. EVM ( £ ) E#:3| SCB ##il|8 (£ )

WERAEH 24~ EVM , W] 4-2 Bosi AT sz, SR RS CE AN F 12C ik, GUI R AR EIE 4 4
EVM.
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I IR226EUN I I INﬂZZGEUN I (
Rev B F2 5

2258

%géﬁ

B 4-2. £/~ EVM %33 SCB &8
421 %8
4.2.1.1 B EF R

NI B ISR ¢ https://www.ti.com/lit/zip/sbac253. & & iHHNL A FHAT —KiIZA R |, 3 HFHZE myTI ik
Fro WEER, BARLIRERE P Anid oy PAMB IRSNFESF , (HB AT SCB. Mk 3 /F I LB B RAFRIZIT .exe 3C
%

4.2.1.2 [EfF

IR B2 T IHRIRENRET | [E1F R RGE T GUI k. N R L GUI R 2 FI TR Hn m] A ol [ 4 558
SCB =il &% . & EAE &S A BT GUI BE FTEHT | 15 A 2430 52 2% 5 sh o GUI.

4.2.1.2.1 B,
a0 S AT AR SR DR DA 20T B B 22 2 A, TR IR IR L D IR S e B . # K EVM iEH:3 SCB.

1. H%, &8F GUI 2R EFFshdife.
a. K SCB =il &4 PC.

b. JA31 GUI
c. MCU mragCadt A\ s [ 1 5087 (DFU) A i it , GUI W] BE 4 A it I 2 1aRe ] 1 ST 21 o
JRAS o

d. WA HBEF , W2 File > Program Device... .
2. WRE 1 BAEMER (838 W Program Device #8K . ), WF-3k SCB #iil# LY MCU L&
DFU 5K, 7& SCB # il #H i@ L pIIE oL T, Aridid DL AT — 57 58 UG ERAE

a. @A
- f£ SCB {1 USB 47 (COM) 311 & i%Ar4 “bsl” .
b. JEREL

o T RARL , RAFBITETR GBRIEMAMEE .
o X T (BT ) BEARICN DFU (A 4-3 iR ) BIRANIISIN  #2 R JFRA T RESET 4%
.
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& 4-3. FITFshE3t A\ DFU R MR A
o W PAMB Bt , A4 XS AT PK Al PK2 BT,
MCU A\ DFU #z0)5 |, BUE T LUl b0 1 dh g i 5 i AR [E F

4.2.1.3 GUI #EFIEE

&R LLFE Chrome. Firefox 5 Safari i & Hrif i DL R #4205 17 GUI @ https://dev.ti.com/gallery/info/
CurrentSensing/INA226EVM_GUI/,

4.21.31 FHRE

HIRKE GUI :

1. WRIRATTOSE B IRENFR 7 O 222, DMRIE—V)IER TAE , 3 H GUI nT LAYE L ZEW 58 EVM [ 14
2. HHMTREE | Btk EVM/SCB #5285 B0 OB PC |, SR G # B AT TR AL GUI Bz,

3. #TJF GUI Composer M HFEST , AL YEEs 53 GUI (TEZ K 4-4 ) .

INA226EVM_GUI
Version 1.0.0
by CurrentSensing (Group)

GUI for the INA226EVM.

a
&1 MO,

& 4-4. GUI Composer &5
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a. GUI B ST A AR GUI. TI & 1BUS F Bo# i mT AR .
b. BRE GUI Composer i , i§HRIEFR N4 T/ Cloud Agent RIS gs 4 [ (155K 4-5) » XEEHIR
Wi 1E 51 README.md 3HEAE 5 .

& 4-5. Tl Cloud Agent

4. TR GUI LB AR |, 1% 5 GUI Composer FFIFER I * bz , RIGHIBIIRRIE (120K
44,

4.2.1.3.2 GUI & EVM &8
HER GUI EEZE EVM | 5% LT D IRERAE -

1. %8 2740 i & ik e B AN A 3 GUL,
2. HHTRELUMG EVM BiE85] GUI |, AR5 %1 README.md SCHE T K B 5hi%E s . WnRERE KT |, GUI A&
T A i B %< i~ Hardware Connected YCZ .

A& GD a COM7:115200 Hardware Connected.

& 4-6. WO EE

a. GUI 2 EJ5 R MiZiE 2 o — et dianas AL R RN A DEVICE CONNECTED.
DEVICE CONNECTED

® INA226

A 4-7. BECER
b. W& GUI k&R Hardware Connected 1 DEVICE CONNECTED XA , i5 1% EVM ] RESET #%
Mok ER.

i WRAZETAENEN | ik Options > Serial Port T () H:Affg44: COM 3 1.

Options

T, Serial Port ...

& 4-8. B BT O
c. MRBEAANSRE A ER: | WEHRE AT GUIVEVM A& IE#ITG R
i WP GUI/EVM A4 10/ , Al ReTR 20T SCB B EEgmts |, an /717 it Frik .
i, AR Z R A AT Lod R LR o — AN AR Bk
1. {£ EVM 5 SCB R IIEEZ MG T , K% EVM L) RESET 4%4H.
Tl GUI A5 It m] DU Bl A v b i A
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2. ¥ EVM &E#2) HAh USB 5.
o TSI USB ££4 45 -
o WRMFEHRZ G PC, a2 FHALAE TS ) USB i 1.

4.2.2 GUI #4E

R4 GUI B AER: , WEAEZ) GUI HK L EE: S EVM. 3 KWl FH &4 GUI TUR IS |, iE SR LR L
o

4.2.21 ZHETF

GUI Bala B e B ETUET R . A AMSER B T8 (E0T ) EbR , ATBERR A 3 g TR

WU, 0T LR AR AN SE M0 GUI 5) EVM #e8% (#5200 GUI 2 EVM 2£42) , T LUBAL e 011
Vi ISR BRI (52 B 4-9) .

J £ B i a

F“T‘C“O”a[ User Guide Datasheet Schematic E2E Forum
Diagram
& 4-9. TR R
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4.2.2.2 [l EHTTF

PTG MERN EVM MG RE | Wt e b O (R ) R, 18 4410 SR T MR TR
il

Number of EVMs: 1EVM + Selected EVM: EVM 1 v

EVM 1
Hardware Switch Settings SW1: GND v SWO: GND v
Shunt/Current Configuration
RSHUNT: ‘ ‘ mQ
Max Expected Current: ‘ ‘ A
CURRENT_LSB: \ \ A
CALIBRATION: 3355 |
True CURRENT_LSB: A
True Max Current: A
Required Sensing Range: mV
& 4-10. RE TR

MBETITH b, 0T DL B B A EVM g | SRJE 0 T4 EVM , 5 0] DAFg B A B A4 1 5% 1 B I B 4 H
FHAT CURRENT_LSB. FIi/™4H 7 U AR R I 7 B

*  Number of EVMs
- M EH T GUI ¥l SCB FiE#H: M EVM #iE.
- iHVER , SCB Al GUI — i Z AL FF 4 1~ INA226EVM.
- FEMALE MOZ W B, 14 “Results Data” &£ ERIAHFRE .
* Selected EVM
- LR BRI YT OZ E T EVM.
- KBSk FRIERET] “Registers” B K EVM.
* Hardware Switch Settings
- ERIXEEE | DMES EVM R BT e B AR5
- HEE, AU N BRI AR R B AT, TR E . EERU R E AT, GUI KPR
i E .
- A EMZ W ER , 4 E N “Results Data” &£ ERAHFRE .
* Shunt/Current Configuration
- A T N0 FR B B #S i 8 CURRENT _LSB 1% & CALIBRATION i 778%. LN & Ui
T AT B
* RSHUNT
- INFTH A RUERHRE , B mQ.
* Max Expected Current

- FA UL B BRI R, BN A
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- W “Max Expected Current” FE IR AT H , WA LLF3)1H% CALIBRATION , i% T H¥ 5 UF &
1§ /1% EVM A& “True Max Current” 1B
« CURRENT_LSB
- XAETFEAAH A CURRENT_LSB i , AN %R, B2 HERYE “Max Expected Current” =
BT .
- WHEFRE , AT ESU TR, HE SO 2 N ik
+ CALIBRATION
- 4% RSHUNT #1 CURRENT_LSB {155 Hi 1) CALIBRATION fH. 4t Bk A Bt | o {E
2-HA %15 N\ CALIBRATION 2717 %% .
- WHEFRE , AT ESU TR, HE SO 2 N ik
- WA LS TR T B A 2 B B A O
+ True CURRENT _LSB
- IXGEMR RS A B 5 FL FHAE AN CALIBRATION 7377 #% T 5545 Hi 1) 5Pr CURRENT_LSB B ( #4718 %
B .
- X “Results Data” #7> 7 H T iHERE .
*  True Max Current
- XM VSHUNT Al CURRENT #7743 H-f# F RSHUNT A True CURRENT_LSB 543 H ik
AL R (RN ES ) S
* Required Sensing Range
- X HLR IR T AR E I U H BE R e K T AL T e 1 B 3
- WEAKFEE “Max Expected Current” , KA “True Max Current” =Bt (1){H .

4.2.2.3 FFEBHETF
LB FH MRS S | W AE AR B 4 (SR ) bR, “Registers” IR & 4-11 s

= INA226 File Options Tools Help

f | Register Map Selected EVM: EVM 1 v AutoRead | Off v Immediate Write v

i Q, search Registers by name or address (0x...) D Search Bitfields Show Bits

e Bits FieLp View
Register Name Address Value
151213121110 9 8 7 6 5 4 3 2 1 o  CONFIGURATION
° v Configuration Configuration / CONFIGURATION / RST[15]
CONFIGURATION @ 0x00 0x4127 0 (B e ) R iz I 06 Bk S o (ol e S B D
RST
Lan CALIBRATION 0x05 0x0D1B o P 1 8 I O T I s O I 5 1 P R I T
v Results Configuration / CONFIGURATION / AVG[11:9]
SHUNT_VOLTAGE 0x01 0x0001 AVG
BUS_VOLTAGE 0x02 0x0000 L v
POWER 0x03 0x0000 .
Configuration / CONFIGURATION / VBUSCT(8:6]
CURRENT 0x04 OxFFFD
VBUSCT
v Flags and Alerts 1.1ms v
MASK_ENABLE 0x06 0x0008 0:(30; |70 |70, | O (0 00
ALERT_LIMIT 0x07 0x0000 00| e(G|lol0|0 000 oG 000D Configuration / CONFIGURATION / VSHCT[5:3]
. VSHCT
v ID Registers
1.1ms v

MANUFACTURER_ID OxFE 0x5449

DIEID OXE 0x2264) Configuration / CONFIGURATION / MODE[2:0]
MODE
Shunt and Bus, Continuous v

& GO ~ COM4:115200 Hardware Connected.

B 4-11. GUI FHFHBIETE
LB TUE , FTRAYE EVM BRI S N B 25 A7 2% . X HLAI Y T — S0 E g 5
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7t “Register Map” LI, i THEBH) Selected EVIM "N F35% Bk s 3 A% Y i 2844

- R, ERAESOZ R ER , e “Configuration” &I AR R E .

- BEEEMIIAERE |, £ MCU H i B BRI S Nt | SRIG 2R T AR Al , DA A s mst . v
B, RS RENRE | TRt SEBIRIERA IR . NRE AR, TR RERE T | E e
WE.

BOINEOLT , FrA i BahE ANS . WRFE | BaT L Immediate Write ¥ & ¥ XN Deferred

Write , LMEAUAEREE S SRS AN

- TG LT — B T B A A A A
o GBI Field View #4r /N T H B E
o AEF SRk Bk B B L Value

R AT ELANM

F1H Auto Read ¥4 R 2> HH 2 A7 as Wi 25 4745, T A2 38T Results Data &7y H B

- WERAEWEEEIERE Auto Read &b T4 TR |, ATRES T LA LR T .

A AF A B A AF B B L, R @ &k,

- WMEXAAERIC A E 2N | HEERIEE.

N HERRI , 0T DR AR A7 A8 I B AR R |, 25 BT B A R S A7 2 IS R 284 itk , W2 File

> Register Data , 4ni& 4-12 HFR.

File Options Tools Help

’ Program Device... Off v

\J .
# Register Data > I save register settings
erNanne AUUres

B Load register settings
on

B 4-12. REFNMBFFRBE
- T @#WAEINEEIE 5 1% Read All Registers 1 LIS I 55 b A4 58 8 77 A7 25 LS
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N T “Results Data” SR IR I 55 U KR A BE

4.2.2.4 ZEHELTIF

5 2 RSO — BN 8 O SRR | % s e oy ( SREE ) Bbr. B 4-13 SR 7 45 R4k vl

f—& S | RIEER N EVM ¥R

, UL AT REH ERA FTA A .

Samples (633 )

Results to collect/show ’
Number of EVMs: 2 EVMs v (e AR NV [ ] #Samples Only
VSHUNT
VBUS EVM1 SW1:GND~ SWO: GND v Delay between samples:
CURRENT 2.200 ms, [% Auto Delay
POWER EVM 2* SW1:GNDv SWO:vysS +
*Selected EVM SAVE ALL PLOTS CLEAR ALL PLOTS
#Samples: |W\
(Changing #Samples clears all plots)
VSHUNT Result
nv Tmv
SAVE PLOT
0.5
CLEARPLOT
0 0 Y-Axis Options:
[J Manual Scale
0.5 05 Max
Min:
> A1
0 100 200 300 400 500 600 700 800 900

Results to collect/show

- SR A I B N S A AE A . WIRAETK T COLLECT DATA #5482 BRI FLE R4 , W
TN ERE R, EVM fERE A A BB A4 ( B E A 7R ) .

- WUERTE EVM REHHRRZEH K — M E |, BABRBASER | EASRELRIR , MEREBEEGE
e W BRI A BN EE .

Number of EVMs

- ¥ Number of EVMs i3 55 B A 4T EH I EVM $& .

WZRE 4-2, TRHEUEZA EVM &8 K.

TELCAL ESUZ B E RS |, ek “Configuration” &R~ _EHAH [R5 E

K 4-13. &R HARE

- GUI — IR Z AU 4 1~ INA226EVM .
- Switch settings

S FIREIT N EVM S FEA R B3 .

- EVM 1 ¥ A 3E bl SRR | BRAEC SRR E .
- FEMALE MO BN, 14 “Configuration” &I _EAAH R E .

W R E
- Collect Data

¥4 F COLLECT DATA Hi4 T 1A R4 54

£ GUI BB R E , DMES R MERK EVM KRB RFF 3

RS 2 A2 | 2577 S ML RN Bk IR A 23 EVM 523
- FEAEE EVM IR ER , ¥ AN EVM BN FTIE R EVM,

o R

(i)

12

INA226EVM /1 /175

English Document: SBOU276
Copyright © 2023 Texas Instruments Incorporated

ZHCUAQO - JANUARY 2023
Submit Document Feedback


https://www.ti.com.cn
https://www.ti.com.cn/cn/lit/pdf/ZHCUAQ0
https://www.ti.com/feedbackform/techdocfeedback?litnum=ZHCUAQ0&partnum=INA226EVM
https://www.ti.com/lit/pdf/SBOU276

13 TEXAS
INSTRUMENTS
www.ti.com.cn FEIE

o fEHEESCR , MCU ji@it USB BULK JliE S BRI & AR 2RIk e S RAE . I — N8 BT 45
RIG, Bk — Nt
- JFTH EVM A 4 RAEILFER N — A “FEARSE” .
EIRTE R AR I v DU 27 7 28 B Do HoAh 2 A7 88 AT S, (FX A] B2 3 hn 250 SR 4R () I AR By
d] .
* 1%~ STOP COLLECT #5115 - RAEHTE
- #Samples Only
o Sk T URRIEHE | GUI K STEBUEMFEA SRR R “#Samples” HEH IR E MRS , H3EIERE
o WMRRIEFZEIRE | GUI 4k BERAEHHE I U1 5OR 1Y) #Samples M4
- Delay between samples
o WEBMEARE RGN E) ] LER .
o GNSRREIRE AR TR RS (B T BRI A AR . EVM BE DL CPU ) |, ] RETCIEIR1S BT 75

(R RE R B 1] o
ERORAE R AR I PT DI o 7 A 25 RS DT A A A7 A 3 AT RS (X AT e 8 0 Bt R AR (Y SR IS
ET8

- Auto Delay

o IRAEFEAHN R S EME A SR IR, WE TR,
© AUREMEHIZA EVM , W EAESERHE A IS RRR R 5 T 1H R A 8 IR [ 5 /M) EVML.

- Save All Plots
* %N SAVE ALL PLOTS #2417] LI¥4 Results to collect/show 43 WA 24 1T ik &5 50f B 1 B {5 A7 31
HL TR
o N EAEFESHIAN SAVE PLOT 241 , WK Z K 2% b i BdE (R AE PRk .
- Clear All Plots

* % CLEAR ALL PLOTS #& I {5 b B A 1 3& 50
o W RNEAEEZEINN CLEAR PLOT #41 A 1% 1% B 2 i B .
- #Samples
o ST SUMGHE P R B R T B e B R ORI RE AL
- WHEESE T ERGAT , DMELE T R SRR .
- Y-Axis Options
* Manual Scale
- 2R I BRI T EVM 50N “Max” Fil “Min” B8 sE AR [F AR FEAE -
- WRREF IR , B EVM BB EA B AR Y BibRE , BAREGR T AR EVM 25 SR8 1S5 ME.
FHfR KAE -
* Max
- WHEERTHTIE EVM 5K Y filifi.
- " “Manual Scale” J5 , RS FBOATE |, W2 B 3378 A N EI R H 157 105 K E .
* Min
- MEFRFYHTHA EVM B/ Y e
- & Manual Scale J& , TR ILFBONT |, WIKE2x B ZhiE 78 AAH B B =4 5 0 /M
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i3 TEXAS
INSTRUMENTS
#E www.ti.com.cn

4.2.3 HRI T/E R 3

% EVM F] LS AR ERA T E70-ii H P S FE RO o B AR I F LA, 15 2512 SRIINGH SR (SMT) 73t
PHESIRIEAE R1 ()RS |, JRilid J1 #IL 5AMT RGN U B sR TR . AR 20 Jit L L8 W] DL B HE 3 U1
M7 Lo SR T OTGE R , IN+ (J1 5185 A1 6 ) A1 IN- (J1 51 3 Al 4 ) BAHPI T .

4.2.3.1 EHRE

BB W VAL E T LR D IR ERAE
(PR i BU R W = WL 2 e N R

a. ¥ 2512 HHFHSSFERE/EESRE IN+ AT IN- SN RT 124 F

b. £ J1 1IN+ F1 IN- S 1 RSN /MRS |, IF oo 4 M5 K 4-14 F1E 4-15 o,

. ﬁu%ﬁ}fﬁ%*ﬂ MRS, TR A R B S Ay, o HB SR LA S K. B
BB Tl @ EEm s - BRI AZE - 707 2847 7 B

2. TEWTHRT h IN+ 1 IN- L”‘?'ﬁﬁ%ﬁ%ﬁf

a. DU 10A UL ERYHEFN | Mt R aA St EVM (AdEm T8 1), Kl 4-14 Fiow.

Load Current Line IN+ Load Current Line IN-
A
V Vv I

® 10A MAX (
36UCH MAX [A<

() |

Z RS
| seu[im]]-@ @
us R6

P~

« | ALERT BUS
=B 000§
L

B 4-14. BIFABT 10A BFE IN+ F1IN - gk
b. # 10A B /N IR SRR BN TR A A BCAE N, AR AT LA EVM. & 4-15 BoR T —Fhk £
A IN+ 1 IN- 375 AMEB 23 2845 e T 1 491 s 1 7 =K
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i3 TEXAS
INSTRUMENTS
www.ti.com.cn FR(E

Load Current Line IN+ Load Current Line IN-

& 4-15. 10A BRI B IN+ R IN - FFLR

WARNING
TSR, EARRRS (RHEEE. S8, EERSE ) o DUKZH N BERA DR, H
W, HRRE I HERAET 10A. B, 5% EVM #3R s\ 5153 .
EVM ] feAE i,

3. K VBUS i ¥ (J1 510 2 ) BT RS HBE ( ATAgZ IN+ ECIN- ) .

a. WHRAMEH VBUS FMEIIRE , ILIEE AT {E ADC % A RAE A HE o
4, h%éﬁ%t@méﬁiu GND i1 (J1 51 1) .
5. R, IR GUI WSS RRA A H .
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i3 TEXAS
INSTRUMENTS
#E www.ti.com.cn

4.2.4 EVM USB B8 (=

WA TE | AIAMER GUI, ik USB & 1 B # 5 EVM 3Tl . B4R 202 | i@id 5§47 COM i I K& T i)
A IR T COM i 8k USB BULK B 4E . XA B Tl | kS . WA GUI
B EVM.,

4.2.4.1 55/ USB 5 HF
{4 Fi 5547 COM i 385 A A% 201 USB i A5 S 1788 -

o R EIHER R ;- setdevice DEVID
- M setdevice 4% /N5 |, 3 H DEVID & XN -
o PRI UL 4 4> LSB it , %kl Ox4A |, WA 10.
- S, MRS T AEEZ A EVM A7 SCB, Ml ERIA R B 1 Ak
* SCB &fEH BN &2 BAF7E 12C 5L SPI, WL BA AT, MIKERIY SPI. 1EIEH: 12C EVM K
Ei R E AL SCB, LUEH 12C.
- Billn, R E A7 A AR Ox4A (¥ INA226 , 1T LA %4 : setdevice 10
- XTAE, EVM 23R [H] JSON #% M AFIRES (- “idle” B¢ “collecting” )
{"acknowledge":"setdevice 10"}
{"evm_state":"idle"}
o A rreg ADR
- Mo ADR 2+ N s L | rreg 1RZ /NG .
- WAL LR REEUVNG | FFHATELL “0x” k. W] LLESH 0 RN frastthht. flan | 2
PRHAT AT A bl OXFF , — 284 R &4

> rreg ff
* rreg 00ff
* rreg OxFF
- A “Ox” B, X7 AU

- XPTAR , EVM 22k IEIJSON KA M4 %*ﬂﬁ(*( “idle” B¢ “collecting” ) :

{"acknowledge":"rreg OxFF"}
{"register":{"address":255,"value":8800}}
{"evm_state":"idle"}
o H AN A - wreg ADR VAL
- Mo ADR HI VAL SRH+oNik] |, wreg 1h2% /N5 .
- WAL AVE AT LR KRB EUNG | HEEATRELL “Ox” Hk. AT DUEREA 0 SRIEAN T AE ARtk A
Biltn , Ea e ik 0x1 5 (E 0x436f , — L84 R i & E s
* wreg 0 436f
* wreg 00 0x436f
* wreg 0x00 0x436F
- R “ox” I, “x” ATANG
- XFFAF , EVM £ ] JSON PR S5 RATRZS (- “idle” B “collecting” ) :
{"acknowledge":"wreg 0x00 0x436f"}
{"console":"Writing 0x436f to CONFIGURATION register"}
{"evm_state":"idle"}
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13 TEXAS
INSTRUMENTS
www.ti.com.cn FEIE

4.2.4.2 7517 USB BULK i35 REH 17

Collect Data Thag MR ¥EFE B E |, BRI IS AT A7 2890 RSB AR s . MLThRETE 7 St A s PR RE iR
£, EARANKAEE EVM BT 28 X B . R R 317 COM i I s sh A 1k, {HE5 Bk iEid USB
BULK iliE &% . 25 ZFH AEC | i#F PL R gt

o EEEIERAEMR L collect timerPeriod collectFlags channelAddressIDs numDevices
- WEERRA NS EATER , HHBANSHI UL FERRRE | ST

timerPeriod
- MCU mH T HHR AL T 284838 (B4 s, 7S 32 ffh ) -
collectFlags

- AR RIELLRE X, W TEA TR ERY 1 RRIEE | 0 B AIEE (R, (U
PRS2 FEfE e M R AR E , BUWERNO) -
VSHUNT = 0b1000
+ VBUS = 0b0100
CURRENT = 0b0010
POWER = 0b0001
channelAddressIDs
- XL LSB kA 12C Hiuhilk sk 4 4> LSB.
B, i EVM 1 A7 T4k 0x41 , EVM 2 £ Tkt 0x43 |, 4L ff)4E A 0000110001 .
NumDevices
- HERRK EVM & (1-4).
- BN, EEE 2.2ms FFUEHEAT — X VSHUNT #1 VBUS #8505 gE |, IXHF EVM 1 ik = 0x41 F1 EVM 2 Mk
= 0x43 [ INA226EVM |, £ 35%3% : collect 2200 12 49 2
SHFA] , EVM £33k 1] JSON #% AR AANRE

{"acknowledge":"collect 2200 12 49 2"}
{"evm_state":"collecting"}
- USB BULK i 8 an M A& 2UHI % - framelD deviceNumlID address registerSize data
NS AR EoRE , T
- framelD (1 577
RN 0. F T HADRELHE X 5%
- deviceNumID ( 1 F71)
XFRET EVM % 51 1D $5-
- fE BB, R AR E D 0x41 1) EVM 1 328, B8R N 1, R E
0x43 ff] EVM 2 B2, iZA6H N 2.
address (1 MF75)
NS AL ) B A
- registerSize (1 N7 )
Je THHE B 7 T 8
- data (—&K 1 AT
TR FHAHREARE |, Hafmm AT,
o IEHERERENE R - stop
- Hrp stop th%N/NE .
- EVM ¥R 5] JSON #% A IAFIIR

{"acknowledge":"stop"}
{"evm_state":"idle"}
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13 TEXAS
INSTRUMENTS
FEIE www.ti.com.cn

4.2.5 PAMB &M

WA T B B2 PAMB 5] L% RS EVM |, Ik EVM AT GUI 1T LU PAMB #4188 (DCO81A) #5
Bl . B 4-16 o T PAMB 5 EVM $23k 51 BIARXH R 51 I T8 VE BN EAE B4R 15 B P s i K EH
NS ST R L RS R IR I & S BUE G R .

PAMB Left Header PAMB Right Header
+3v3 2 o o 2 45V 1 O o 2 GND
P2 210 o4+—2GeND $ 1o o2
PPO &0 O4—2 o o+—
PP1 o © o O
9 o o 10 9 o o 10
11 o o 12 11 o o 12 PQ2
pa0 B 1o o4 B 1o o]—%ra3
15 o o 16 15 o o 16
PNs L to o8 T 1o o2 rat
PN4 19 o o 20 19 o o 20
EVM Header
pPQ1 4 O of—2+5v
PQo 2 o O 4 GND
pQ2 2 o © 5 +3v3
PQ3 L o O 8 pD2
ppo 2 o o+ pNs
ppt 10 o+—2pNg
& 4-16. EVM 5 PAMB [f1i%4;
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13 TEXAS
INSTRUMENTS
www.ti.com.cn 1%

5 HE%

AL T EVM T RS Mot
5.1 BRI IC

KA INA226 S H et

U1 72 INA226 HfiE AR, C1 Fl C2 253K RS | B AL AR |, A Bh T PR s YR e 5 I 7E 75 B PRk
Fre Rt m . B PR EH S R4 ¥ LED D1 H T35/~ EVM {5 i@ Ha .

S| AT B SRR A TP - TP12 34T, iEER , N7 RN , GND FiBa w4 S .
5.2 INE 5K
KB T NS S AR L

J1 R EERER . J1 51 BT RS ERER S EVM Baihig. J1 15180 2 F T 245 88 N Y
VBUS. 5| 3. 4 #8% IN-, 51 5. 6 S IN+. N T 7RI , IN+ A1 IN- G A5,

R1 AT FAME RS 2512 (e s i b . i as i BLE T J1 ) IN+ A1 IN- 37 b WA &2, WTE
AL DN B I 0 22 7 L s

C3. R2 fl R3 HA M — AT E I A JETE 2%, R2 A1 R3 BRIAGERC 7 0Q HaPH. i FHH A JEN I | 3 e s ik
HNmE B . Al IEERA R2 Al R3 M5 ML T C3 RIEMMEE . ARMANEBENTEZEE | ESHEEE.

5.3 B
AT T B B T

J2 A1 I3 &R 5 AT LR 5| BE R 2 SCB il 83 sl L Ath EVM 1) ZH:L 5. I3 &R R4 M EVM/
SCB , 1 J2 BRI AEM 2 A EVM. R5 1 R6 FI/E X3 10 3] K 3y B fH 2%,

SWO 1 SW1 W E T 283410 12C Hbdk., 2# A EVM 5 H 2 X I=H)88 ( IE SCB =28 ) i Z N EVM I | IX
FHOEIRA . 2457 SCB #2841 GUI W& ~N— X fE H IIA EVM.

R8 FfE ALERT 5| BIR bhz s BHSS | %5 BB 5 J2 A1 J3. LED D2 IR LS R7 F T8/~ ALERT {a] i fitk
K. B3k J4 Fpksk SH-J4 B TEt WigF J3 SEWr I ALERT 5|5 EVM ALERT 2R fid:. X FEAAMH 2 A
EVM BHEH , MEAEAT E ALERT SZ8H 0] LZEREA EVM & 2 5l ) ALERT LED.
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JHHE, PCB 47/ FIRY L

13 TEXAS
INSTRUMENTS

www.ti.com.cn

6 53 E. PCB iR ypkliE

&

FLBR AR AT J=) AR AZ LU s o IX LR BT B AE o BB AR AT JR) o TS TiliE EVM PCB.

6.1 FEH

K 6-1 fi® 6-2 78 T INA226EVM I E . & 6-1 &7~ T EVM K. K 6-2 HB7x T EVM [E R AL ES

(G

+3V3
$R6
N TP9 21.0k
& PN5 SWO
sCL = |t
3 3v3 +3V3  GND
2 —
i 3
Ul SRS
O <
al Tpg  JLOK 4
: b
VIN- SCL e
8 e o zzx SDA PN4 ? P10 PN4 5
A0
1 PN5 6
L vevs AL TP11
i ALERT 3 ; MNT_1
7 4 57 TP12 g | MNT.2
VS+ GND MNT_3
—L _L +3V3 10 =
R Sy C1 C2 (B INA226AIDGSR GND PD2_B R8 MNT_4
10k 1pF 0.1uF TP3 ALERT 27k = CUS-14TB
VS P6 . oo
D2
_L GND NG K
- 10k
GND g % swi
pp— 1
ND =
. +3V3  GND
J3A  13B = 2
+_5|y GND —
PQl 3
=V - | - ] L o2 A
2 PQO 4 2 _PD2 B 4
J__l 210 o+ i - 3V — &
B3 = 115 o2 PQ2 | g | b GND SHJ4 14 PN4 5
T_GnD s |5 ols ;
PD2 B__ 8 7 PQ3 PD2_A PN5 6
o0 9T - -
a5 gln PPO h ﬂ PNS ; MNT 1
PP1 E E PN4 o | MNT_2
o] MNT_3
MNT_4
= CUs-14TB
GND

] 6-1. J7 2 /& e
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13 TEXAS
INSTRUMENTS
www.ti.com.cn JFPE, PCB i I FE

T

o OO O <9

X X X

PCB PCB PCB
LOGO LOGO LOGO
Texas Instruments CE Mark FCC disclaimer WEEE logo

'l

CAUTION HOT SURFACE

772
Assembly Note
These assemblies are ESD sensitive, ESD precautions shall be observed.

773
Assembly Note
These assemblies must be clean and free from flux and all contaminants. Use of no clean flux is not acceptable.

7724
Assembly Note
These assemblies must comply with workmanship standards IPC-A-610 Class 2, unless otherwise specified.

775
Assembly Note
Trim the leads under J1 (back of PCB) to give clearance from surface

& 6-2. IR 2 &
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13 TEXAS
INSTRUMENTS
JFPEI, PCB A A1 FLE www.ti.com.cn

6.2 PCB #ij&
6-3 &5 6-6 JE/~ 7 INA226EVM [ PCB JZ.

10A MAX
36UCM MAX

& 6-5. LA & 6-6. )2

22 INA226EVM H /757 ZHCUAQO - JANUARY 2023
Submit Document Feedback
English Document: SBOU276
Copyright © 2023 Texas Instruments Incorporated


https://www.ti.com.cn
https://www.ti.com.cn/cn/lit/pdf/ZHCUAQ0
https://www.ti.com/feedbackform/techdocfeedback?litnum=ZHCUAQ0&partnum=INA226EVM
https://www.ti.com/lit/pdf/SBOU276

13 TEXAS

INSTRUMENTS
www.ti.com.cn JRPEIK], PCB 77 /e I #L
6.3 YRR

% 6-1 #2417 INA226EVM H8e4h%13 .

% 6-1. YIRlE R

PRRRF HE B | U HESE =HRS HIE R
IPCBA1 1 El il i, AR INA226EVM NES
C1 1 1uF AR B, 1uF |, 16V, +/-20% , X5R , 0402 0402 GRM155R61C105MA12D  |MuRata ( A )
Cc2 1 0.1uF | %% |, &, 0.1uF , 50V , +/-20% , X7R , 0402 0402 GRM155R71H104ME 14D MuRata ( #H )
D1. D2 2 Aty |LED, At , SMD 0805 VAOL-S8WR4 Visual
Communications
Company, LLC
H1. H2. H3. H4 |4 Bumpon , ERFE |, 0.25 X 0.075 , i&H] 75x250mil SJ5382 3M
J1 1 Ui FH 6POS TN SMM PCB 412571 % « 418 ZZ5 1585 5| 2k HDR6 691137710006 Waurth Electronics
(HURFFHT )
J2 1 #EiME , 2mm , 6x2 , 4, RIA, TH $HEE , 2mm , 6x2 , NPPN062FJFN-RC Sullins Connector
R/A, TH Solutions ( F&3% AR}
HARAT )
J3 1 sk, 9L, B, 1247, 0.079" (2.00mm) HDR12 NRPN062PARN-RC Sullins Connector
Solutions
J4 1 #3k, 2.54mm , 2x1, &, TH 3L, 2.54mm 61300211121 Wurth Elektronik
2x1,TH
R2. R3 2 0 HFH, 0, 5% , 0.125W , 0603 0603 MCT06030Z0000ZP500 Vishay/Beyschlag
( Bt/ R )
R4. R7 2 10k |#FH , 10k , 5% , 0.063W , AEC-Q200 0 % , 0402 0402 CRCWO040210K0JNED Vishay-Dale ( Jatt:
) )
R5. R6. R8 3 4.7k |HFH , 4.7k , 5% , 0.063W , AEC-Q200 0 %% , 0402 0402 CRCW04024K70JNED Vishay-Dale ( Jgtt:
k)
SH-J4 1 SRS, 2.54mm | &, B 434  2.54mm 60900213421 Wurth Elektronik
gk
SWO0. SW1 2 WENIToC SPAT i3 |, HM SMT_SW_11MM3_4M |CUS-14TB Nidec Copal
M1 Electronics ( H77F}
FHTHRAA )
TP1. TP2. 12 MR M SMT Testpoint_Keystone_  [5015 Keystone
TP3. TP4. Miniature
TP5. TP6.
TP7. TP8.
TP9. TP10.
TP11. TP12
U1 1 EMIE . XA R RYThR LR | B 12C #10 , 2.7 E 5.5V, -40 & 125 |DGS0010A INA226AIDGSR PRI (T1)
TRICHE | KA 10 5/ SOP (DGS10) ##3: |, LR IF R ( #F & RoHS frdE
TEBAIR )

ZHCUAQO - JANUARY 2023
Submit Document Feedback

English Document: SBOU276

Copyright © 2023 Texas Instruments Incorporated

INA226EVM /775 %

23



https://www.ti.com.cn
https://www.ti.com.cn/cn/lit/pdf/ZHCUAQ0
https://www.ti.com/feedbackform/techdocfeedback?litnum=ZHCUAQ0&partnum=INA226EVM
https://www.ti.com/lit/pdf/SBOU276

JHHE, PCB A7/ HIRY L

13 TEXAS
INSTRUMENTS

www.ti.com.cn

£ 6-1. YIRHE # (continued)

FRRAF HE - L g BAES HE R
C3 0.1uF | %% | B@% , 0.1uF , 100V , +/-10% , X7S , AEC-Q200 1 % , 0603 0603 CGA3E3X7S2A104K080AB | TDK
FID1. FID2. 0 HfEbrid. %A TEMFS RN E. TiEH TiEH TiEH
FID3
LBL1 0 HEEEIITEIRRSE |, 0.650" ( %8 ) x 0.200" ( & ) - 10,000/% PCB 7% , 0.650x |THT-14-423-10 Brady
0.200 i~}
R1 0 10m |10mQ +0.5% 2W J LHiBH 2512 ( 2l 6432 ) , 5% AEC-Q200 , Hiftk: |2512 PCS2512DRO100ET Ohmite
Q W, B4 e
24 INA226EVM /75 H
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ERFRNRREH
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